Release Notes for DataViewer Designer Enterprise

v2.0 build 03

1.

2.

Problem: The Query Builder would not work in Windows Server 2008 in some
situations.

Status: This problem is resolved by upgrading the connection components for the
Query Builder.

Upgrade: The Fast Report controls have been upgraded to the latest version.

v2.0 build 02

1.

New Feature: When opening DataViewer Enterprise from DV Designer, it now
shows the Config that is currently open in DV Designer. This makes it easier for
Configuration Managers to test the DataViews they created.

Major New Feature: The Levels tab now supports multiple Detail Levels which
allows the Configuration Manager to include multiple details of data in the
Master/Detail Grid and the Form Report. This is needed in the Form Reports
when you want to display sub-reports of multiple sources of data. A perfect
example of this is the DWR data in MMS where you may want to display
Detailed Assets, Labour, Equipment, and Materials for each DWR Line. Each of
these details would be available in the Form Reports and would appear as separate
tabs in the Master/Detail grid.

New Manual: The user manual for the Form Report (which the vendor calls:
“Fast Report.Net User’s Manual”) is now included in the install. To open this
manual, click on the “Form Report User Manual” menu item under Help in
DataViewer Designer. Alternatively you can go to the “DataViewer Designer
Enterprise” menu under “iBOS Tools” in the Windows Start menu. Then click on
“Form Report User Manual”.

Enhancement: The Display Format column on the Field Info tab now shows the
default format "# ##0.00" for the float field so it will be more obvious to the user
why the data is being rounded.

Modification: Changed the Binning Scheme dialog to set the Default Output as
empty string when the user does not provide the Default Output value.

Enhancement: The Connection Info data is now included in the export of the
DataViews. When importing the DataViews, DataViewer Designer will add that
connection record automatically if it doesn’t already exist. This is so the
Configuration Manager doesn’t have to add the Connection Info manually when
sending DataViews to remote users.

. Problem: An error occurred when the user is trying to save the new form report

name containing an apostrophe.
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1.

Status: This problem is resolved.

Problem: An error “[.Net SqlClient Data Provider] Timeout expired. The
timeout period elapsed prior to completion of the operation or the server is not
responding.” occurred when the Config Name was renamed and the Apply button
was pressed.

Status: This problem is resolved.

Problem: An error “[.Net SqlClient Data Provider| Violation of PRIMARY KEY
constraint ‘PK_tbIDVLevelsAgency’. Cannot insert duplicate key in object
‘tbIDVLevelsAgency’.” occurred when the Apply button was pressed on the
Levels tab.

Status: This problem is resolved.

Problem: Renaming the Config Name to be the same as the old name but with
different upper or lower case characters causes the DataView data to be corrupted.
If this occurs please rename back to the original Config Name.

Status: This problem is resolved.

Problem: When the Populate Field Info feature is used after the Field Info grid
has been cleared by using the Clear Field Info button, the field orders are not
restored to the original state. Note: this is only intended to work if you do not
move off of the level that you are on before pressing the Populate Field Info
button.

Status: This problem is resolved.

v2.0 build 01

1.

New Feature: Added the Year(), Month(), and Day() SQL functions to the Date
section of the Expression Builder to extract the Year, Month and Day parts of a
Date respectively. Kept the DatePart() function for added flexibility.

New Feature: Added a new function to remove all spaces from a given character
expression (similar to the fnvmxRemoveNonDigits function). This function is
called fnvmxRemoveSpaces.

New Feature: Created a new field called “BinCriteria” that is formatted as
below and uses the Alias field (instead of “IsNull([TotalofBreaks], 0)”) for display
purposes only in the DV Bins DataView.

Here is an example of what will be displayed in this field:

Output: ‘Future’
When: Original Year of Construction > Year As Of

Output: ‘Excellent’
When: Percent Plastic = 100

Output: ‘Poor’



When: Metal Length > 20
AND Modified Break Density > 2

Output: ‘Good’
When: Percent Metallic = 0
AND Total of Breaks < 4

Output: ‘Good’
When: Percent Metallic > 0
AND Total of Breaks = 0

Output: ‘Good’
When: Percent Metallic > 0
AND Metal Break Count =0
AND Modified Break Density = 0

Otherwise output: ‘Fair’

New Feature: The last SQL View name that is entered when saving a SQL View
in the table as the Level is now stored each time and used as the default the next
time a SQL view is saved. The user can change it if they want. When exporting
to a SQL View the first time, the name of the DataView without any spaces is
used as the default.

Enhancement: Modified the Delete button for DataViews to display a multi-
select check list (like the Delete Field Info) so the user can delete multiple
DataViews at once even if they have Level(s). All Levels for the selected
DataViews will be deleted as well.

New Feature: Added a button on the Field Info to the right of the Populate Field
Info button called Add Bin that displays a popup dialog with a pick list of bins to
choose from. Once selected a bin field is inserted into the Field Info. The Alias
is set to the name of the Bin selected and the Field Name the same but enclosed in

[].

New Feature: Added a button on the Field Info to the right of the Populate Field
Info button called Copy Field Info button that displays a dialog with a pick list of
DataViews and Levels (two columns) to copy the Field Info from. Then the same
checklist that is used in the Populate Field Info button is displayed so the user can
select what fields to copy. Fields that are selected that already exist are
overwritten.

Enhancement: Increased the default height of the Order By dialog boxes so that
less scrolling is needed.

Enhancement: The case statements in Bins are formatted as follows so that they
are easier to read in the DV Bins DataView:

CASE
WHEN [Original YearOfConstruction] > [ YearAsOf]
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THEN 'Future'
WHEN ROUND([PercentPlastic], 2) = 100
THEN 'Excellent’
WHEN ROUND([MetalLength], 2) > 20
AND ROUND(IsNull([ModifiedBreakDensity],0), 2) > 2
THEN 'Poor’
WHEN ROUND([PercentMetallic], 2) =0
AND IsNull([TotalofBreaks], 0) < 4
THEN 'Good'
WHEN ROUND([PercentMetallic], 2) > 0
AND IsNull([TotalofBreaks], 0) = 0
THEN 'Good'
WHEN ROUND([PercentMetallic], 2) > 0
AND [MetalBreakCount] = 0
AND ROUND(IsNull([ModifiedBreakDensity],0), 2) = 0
THEN 'Good'
ELSE 'Fair' END

Problem: The Primary Key Field Name and Link Key Field Name pick lists on
the Levels tab store incorrect values when the pick list items are selected.
Status: This problem is resolved.

11. Problem: Save DataView As does not include Detail grid settings.
Status: This problem is resolved.

12. Problem: If there is something invalid in the bin the Test Field SQL will not
display anything. An error should be displayed
Status: This problem is resolved.

13. Problem: If the Field SQL is invalid and the Expression Builder is displayed, the
list of fields will be empty because it cannot load the query. It should load the list
of fields with valid Field SQL.

Status: This problem is resolved.

14. Problem: Calculated fields are not displayed in the Binning Scheme designer.

Status: This problem is resolved.
v2.0 build 00

1. Enhancement: Replaced the old reporting tool with the new one called “Fast
Report”. This new reporting tool supports sub-reports and it loads the report much
faster than the old one.

v1.8 build 9
1. Problem: The Binning Scheme screen in DV Designer causes the error “Cannot

insert the value NULL into column ‘BinningSchemeDetails_ GUID’”” when the
user copies the line and tries to save the record.
Status: This problem is resolved.



2. Problem: When a DataView is renamed in DV Designer, the Source DataView in

Binning Scheme is not changed.
Status: This problem is resolved.

3. Problem: In DV Designer, it is too slow to change the Data Type column value in
the Field Info grid.

Status: This problem is resolved.
v1.8 build 8

1. Modification: Added validation to the Import DataViews dialog to let the user
know when the Group is changed and if the user wants to import this Data View
into a different Group within the same Configuration, to also change the Data
View Name.

2. New Feature: Added the “Auto Populate” button to the Field Info tab to
automatically populate all unique values into the Images grid so the user only has
to set the image column.

v1.8 build 7

1. Problem: The Progress Meter dialog does not put the main screen in edit mode
when the OK button is pressed which may cause the changes to not be saved.
Status: This problem is resolved.

2. Modification: Added the Date Created field to all the tabs for showing the date
when the record was created.

v1.8 build 6
1. New Feature: Added some meaningful display formats to the Display Format

screen for all applicable data types (Date, Time, Float, Integer, etc).

2. New Feature: Added a function to the Populate Field Info screen to split the

mixed case words for the Alias column to make the column names for the grid
more user-friendly.

New Feature: In the Populate Field Info screen, added a check box called “Auto
Hide ID Fields”. If it’s checked, all the fields that end in “_ID” will be positioned
at the end of the list and the Visible In Grid, Chartable, and Can Summarize
columns are marked as uncheck.

New Feature: In the Binning Scheme screen, added the Source Field column to
the Discrete grid. The grid cell for this field is only editable for the selected
Operator value other than “(Custom)”.

New Feature: In the Binning Scheme screen, added an ellipsis button to the
Output Value column on the Discrete grid. This button opens the Expression
Builder screen for building the output value expression. This is a very powerful



feature that enables users to create bins that compare fields to other fields or
mathematical expressions.

6. New Feature: Added an ellipsis button to the Field SQL column on the Field Info
grid. This button opens the Expression Builder screen for building the field SQL
expression so it is easier for users to do SQL math such as adding two fields
together as well as other SQL expressions without knowing SQL syntax.

7. New Feature: Added the Owner column to the Field Info grid so if a user wants
to modify a VEMAX DataView and keep the modifications when they import
updated DataViews from VEMAX they can set the Owner to Agency.

8. Problem: The Form Report is not saved properly when it’s loaded from the Form
Report file in the Form Report Designer.
Status: This problem is resolved.

v1.8 build 5
1. Modification: Changed the Import/Export DataViews utility to support new
table structures.

v1.8 build 4

1. New Feature: Added a new menu item: “Tools\Configuration Selection” to open
the Configuration Selection screen. This menu item is only enabled when the user
security setting “User Can Select Configuration” is not set to “No”. The
Configuration Selection is for granting the DV Designer User rights to edit the
selected configurations. When the security setting “User Can Edit All
Configurations” is set to “Yes” the user can edit all the configurations regardless
of the selected configurations from the Configuration Selection screen.

2. Problem: The Binning Advanced Filter field pick list excludes ID fields if they
are set to show in the field list grid.
Status: This problem is resolved.

3. Enhancement: Binning: The dialog that displays when you click the ellipsis
button in the Source Values column used to be captioned Advanced Filter. The
caption is now formatted as: “Bin Criteria for: X"’ where x is the Output Bin Value
for the line where the dialog is called from.

4. Enhancement: When you close the Set Order dialog for Groups and DataViews
the Navigator is now refreshed.

v1.8 build 3
1. New Feature: The Import/Export DataViews feature now imports and exports
the Pivot Grid with the agency layouts. (Pivot Grids are setup in DataViewer
Enterprise.)



v1.8 build 2

1. Enhancement: Improved the flexibility of the import so it is more robust between
Versions.

2. Enhancement: Added the following text boxes to the Binning Scheme screen:
Source Config Name
Source Data View
Current Data View
The Source DataView and Current DataView text boxes will have a yellow
background if both values are not the same. This warns the user that the Current
DataView may not be compatible with the Source DataView.

3. Enhancement: The Save As feature for an existing Bin now allows the user to
select a different DataView for the Bin. This allows the user to effectively copy
the Bin for use with a different DataView.

4. Enhancement: Added a Convert Field Names dialog to the Binning Scheme
dialog to convert the field names to match up with the current DataView. This is
for use with the Save As feature described in the enhancement above. This dialog
only applies to Discrete binning type.

5. Enhancement: Added the Set Order button to the Group tab for setting the order
of the Groups.

6. Enhancement: Added the Set Order button to the DataView Details tab for
setting the order of the DataViews.

7. Enhancement: The Set Order dialog now supports drag and drop for setting the
order easily.

v1.8 build 1

1. Problem: The Import DataViews feature does not import the Conditional
Formatting data.

Status: This problem is resolved.

2. Problem: An error “Object reference not set to an instance of an object” occurs
when setting up the Progress Max Value or Progress Tolerance field.

Status: This problem is resolved.
v1.8 build 0
1. Upgrade: The third party controls (such as the grids, the navigator, form report,

edit controls, etc) have been upgraded to the latest version.

2. Enhancement: Improved performance and usability for Form Report Designer



and Form Report Preview.

v1.7 build 3
1. New Feature: Added new Editor “Open File” which combines the text display
with an ellipsis button. In DV Enterprise when the button is pressed, the program
uses the Windows association to open the file.

v1.7 build 2
1. Enhancement: Improved performance on loading DataViewer Designer.

2. Problem: An error “Violation of PRIMARY KEY constraint
PK_tblDVFieldlmage” occurs when an image record is added in the Field Info tab
for the field with Picklmage editor type.

Status: This problem is resolved

3. Problem: An error “[mscorlib: GetvmxFieldsFromFieldInfo()] Item has already
been added. Key in dictionary: ..” occurs when loading the field information.
Status: This problem is resolved.

4. Problem: The Import DataViews feature does not import the Form Report data.
Status: This problem is resolved.

v1.7 build 1
1. Problem: The SQL statement generated by the “Show SQL” button does not
include proper field alias.
Status: This problem is resolved.

v1.7 build 0
1. Upgrade: The third party controls (such as the grids, the navigator, form report,
edit controls, etc) have been upgraded to the latest version.

v1.6 build 1
1. Problem: The Query Builder button causes the error message saying, “The
database does not exist” when the button is pressed and the SQL Server Name for
the database connection is the IP address or different from the DataViewer
Enterprise’s SQL Server Name.
Status: This problem is resolved.

v1.6 build 0
1. Upgrade: DataViewer Designer Enterprise has been upgraded to support version
2 of the Microsoft .NET Framework.
The iBOSToolsPrerequisites_2_0.exe install is needed for this version of
DataViewer Designer Enterprise.

2. Upgrade: The third party controls (such as the grids, the navigator, form report,
edit controls, etc) have been upgraded to the latest version.



3. Modification: Grid and Form Layout settings are now stored by User ID instead

of Computer/Windows User ID combination. i.e. the settings are only specific to
the user, not the computer that the user is running the software from.

Problem: The Export DataViews feature should not include the user settings data
to the export file.
Status: This problem is resolved.

Problem: The Load Data button on the Test Field SQL tab causes “Index was out
of range” error when the button is press and the SQL statement contains an
invalid column name.

Status: This problem is resolved.

v1.5 build 12

1.

Problem: Every time the Level node is clicked, the DataViewer Designer will
update the Binning Scheme data. It should only update the data once.
Status: This problem is resolved.

Problem: When the Level node is clicked, and there are many Binning Scheme
fields the DataViewer Designer title bar will flash many times.
Status: This problem is resolved.

Problem: The DataViewer Designer cannot be closed if an un-handled exception
occurs when the user tries to close it. The user has to terminate the application
using Windows Task Manager.

Status: This problem is resolved.

Problem: Occasionally a column foreign key constraint error occurs when the
user tries to create and save a new level for a DataView.
Status: This problem is resolved.

v1.5build 11

1.

Problem: An error “Object reference not set to an instance of an object” occurs
in the Export dialog when exporting the SQL views.
Status: This problem is resolved.

Problem: An error “Type of value has mismatch with column type. Couldn’t store
<System.Drawing.Image> in Open column. Expected type is byte[]” occurs when
running DV Designer in Windows Vista.

Status: This problem is resolved.

v1.5 build 10

1.

Modification: The enhancement in item 3 in the previous version listed below
has been modified so the folder validation is not case-sensitive.



v1.5 build 9

1.

10.

Modification: In the Field Info tab, removed the data type “Binary” from the
“Data Type” dropdown list. Removed editors that are not supported (i.e. “Color
Edit”) from the “Editor” dropdown list.

Modification: Validation has been added to ensure that “Max Records in Grid”
and “Max Records in Chart” cannot be less than zero.

Enhancement: When the user clicks the ellipsis button to set an image file for the
“Small Image File Name” or “Large Image File Name” fields on the “DataViewer
Details” tab, a dialog opens to let the user select an image file. The default and
only available folder for sidebar items is set in the “Globallnfo.dat” file and this is
the folder the dialog will default to. If the user tries to select a file from a
different folder, a message will now display informing the user they cannot select
that file and the dialog will be re-opened using the correct folder.

The same enhancement has been added to the Images on the “Field Info” tab. The
default folder for Pick-list images is also set in the “Globallnfo.dat” file.

Enhancement: The Config pick-list is now wider to allow for longer Config
names.

. Enhancement: The size of the dialogs for “Delete Field Info” and “Populate

Field Info” are now larger.

Enhancement: On the Field Info tab, if a field’s data type is Date Time and the
selected editor is “Progress Max Value”, the dialog for setting up the Progress
Max Value only allows the % option in the Output panel (the Value option is
disabled as it does not apply).

Enhancement: On the Field Info tab, validation has been added to inform users
if they have selected the Progress Tolerance editor on a field that is Date Time.
This combination is not supported and will cause errors in DataViewer Enterprise.

. Problem: If the user chooses a Connection Info that is not valid, when the user

clicks “Query Builder” on the Level tab to create a query an error message
displays informing the user that the database does not exist and asks if the user
wants to Cancel the operation, if the user answers “Yes” then DataViewer
Designer closes.

Status: This problem is resolved.

Enhancement: On the DataView Details tab, validation has been added to
inform users if they have selected a Connection Info that is not valid.

New Feature: On the Level tab and the Test Field SQL tab, the count of records
loaded after the Load Data button is clicked is now shown in the footer of the
grid.



v1.5 build 8

1.

Enhancement: Improved the validation when saving files and settings to folders
if the user does not have proper permissions to read or write to those folders.

. Enhancement: Improved the validation when there are no Field Info records

populated and the user clicks the Load Data button in the Test Field SQL tab.

. Problem: On the Field Info tab, when the user clicks the “Save As” menu item in

the “SQL View” menu, a dialog opens to ask the user to enter a SQL View name.
If the name already exists in the database DataViewer Designer will display a
message asking if the user wants to overwrite the existing SQL View. If the user
answers ‘No” then Designer opens a dialog again to let the user enter another
name. At this time if the user clicks the “Cancel” button an error would occur.
Status: This problem is resolved.

. Enhancement: Improved the validation when two or more tables are joined in

the SQL Statement and there are multiple fields selected with the same name. In
this situation, DataViewer Designer will add an alias for each field using table
name plus “_" and field name.

. New Feature: When populating the Field Info records (using the Populate Field

(132

Info button), if the field name contains an underscore and does not end with
“_ID” then each underscore will be replaced with a space in the Alias column.

. Enhancement: When DataViewer Designer shows the Field Info SQL statement

to the user, it adds information about the Level in a comment part before the SQL
statement and a blank line after the SQL statement.

. Problem: If there is “TOP *** PERCENT “ clause in the Level SQL, SQL

Server 2005 will ignore the "Order By" clause in that query.
Status: This problem is resolved.

v1.5 build 7

1.

New Feature: When you select the “Save DataView As” menu item from the
“File” menu, DataViewer Designer will switch to the newly created DataView in
the navigator.

New Feature: When you select the “Save DataView As” menu item from the
“File” menu, DataViewer Designer will check the “Show in DataViewer for me”
checkbox in the newly created DataView if it is checked in the original.

Problem: In Form Reports, if the “Save As” button is clicked to save the current
Form Report with a new name, and the new name already exists, DataViewer

Designer will asks if the user wants to overwrite the old Form Report. If the user
answers yes, it should replace the existing Form Report but DataViewer Designer
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may not overwrite it correctly.
Status: This problem is resolved.

Problem: In various DataViewer Designer screens the shortcut “ctrl + C” does
not work.
Status: This problem is resolved.

New Feature: When DataViewer Designer is in edit mode (some controls are
greyed out), some menu items are disabled (to match the corresponding buttons).

Modification: In Form Reports, when the Form Report Designer is closed
DataViewer Designer will write the Form Report as a temporary file to the local
hard drive. It used to use the last directory accessed by DataViewer Designer. It
now uses the setting “User Temp Path” for “DVDesigner” in the “Globallnfo” file
as its default path.

Problem: After opening DataViewer Designer, if setting files saved to the local
hard drive are deleted and then DataViewer Designer is closed, an error may
occur.

Status: This problem is resolved.

Problem: In the Import screen, sometimes the checked status of the control
“Agency Layout” may not match the column “Agency Layout” in the grid. The
same problem occurs with the checkboxes “Data Views” and “Agency Field
Values”.

Status: This problem is resolved.

Enhancement: Improved the message displayed when the Load Data button is
clicked if SQL Statement on the Level tab is invalid.

Modification: On the Field Info tab, if there are no records in the grid,
DataViewer Designer will disable the “Set Field Order” button and the menu
items “Save As” and “Auto Create SQL Server View” in menu the “SQL View”.

v1.5 build 6

1.

Problem: On the Levels tab, if an SQL Statement has “Distinct” and “Order by”

clauses like:
SELECT DISTINCT *
FROM <TableName>
WHERE ...
ORDER BY ...

when the user clicks the Apply button to save this Level SQL or clicks Load Data
button to test it, an error may occur.
Status: This problem is resolved.

Problem: On the Field Info tab, when the user clicks the “Save As” menu item in
the “SQL View” menu, a dialog opens to ask the user to enter a SQL View name.



If the name already exists in the database DataViewer Designer will display a
message asking if the user wants to overwrite the existing SQL View. If the user
answers ‘No” then Designer opens a dialog again to let the user enter another
name. At this time if the user clicks the “Cancel” button an error would occur.
Status: This problem is resolved.

v1.5 build 5

1.

New Feature: On the DataView Details tab, added a check box “Show in
DataViewer for me”. When the designer changes the check / uncheck status, the
DataView will be selected or un-selected in DataViewer Enterprise for this user.
This feature is useful so that the DataViewer Configuration Manager does not
need to add new DataViews to the list for themselves.

New Feature: Added Tools menu in the bar menu. The new Tools menu has a
DataView Selection menu item so the DataViewer Configuration Manager can
select DataViews for different users the same way as the DataViewer Enterprise.

New Feature: In the File menu, added “Save DataView As” menu item to save
the current DataView as another DataView as a way of copying DataViews. The
new DataView can be the same name in different configuration or a different
name in the same configuration.

Modification: In the Import DataViews screen, if DataViewer cannot find the
default Import file path, is uses the default Export file path as its default file path.

Modification: On the Levels tab, changed “Filter by Computer Name” to “Filter
by Windows User Name”.

Problem: In the Import DataViews screen, if the user clicks the Close button to
close the screen, sometimes an error may occur.
Status: This problem is resolved.

7. Modification: Made minor cosmetic changes.
v1.5 build 4
1. Problem: On the Levels tab, if the SQL Statement is formatted with multiple

lines like:

SELECT *

FROM <TableName>

WHERE ...
when the user clicks the Apply button to save this Level SQL, DataView Designer
changes its original format and puts the entire SQL Statement into a single line
like:

SELECT * FROM <TableName> WHERE ...
Status: This problem is resolved.



2.

Problem: On the Levels tab, text that contains single quotes was being replaced
with multiple sets of single quotes.
Status: This problem is resolved.

v1.5 build 3

1.

Problem: On the Levels tab, sometimes the SQL Statement may be parsed
incorrectly. This may cause a problem when displaying the query in Query
Builder.

Status: This problem is resolved.

Problem: On the Levels tab, if the Level SQL has any fields with more than two
spaces between words in the field name and the user clicks the Apply button,
DataViewer Designer will remove the extra spaces (leaving only one space
between words). This will result in an invalid field name, which will cause an
error.

Status: This problem is resolved.

Modification: Changed the DataViewer Designer Enterprise application icon.

Modification: For the Form Report preview screen, removed the “Print direct”
item from the File menu and the “Print direct” button from the Tool bar.

Modification: When the user prints messages displayed by DataViewer Designer,
the Application name is now DataViewer Designer Enterprise.

New Feature: On the Help menu, added “Select Statement Basics” item. This
menu item opens the Select Statement Basics user manual.

Modification: For the grid, removed the Print Direct button from the grid print
preview screen.

Modification: Made minor cosmetic changes.

v1.5 build 2

1.

Problem: On the Levels tab, when the user clicks the Apply button DataViewer
Designer will process the Level SQL. Query Builder may not show the new
Level SQL properly after this.

Status: This problem is resolved.

Problem: On the Field Info tab, if the Level SQL uses Functions for some fields
in the Select clause, DataViewer Designer may not populate those fields properly.
Status: This problem is resolved

Problem: On the Field Info tab, when the user clicks the “Clear Field Info”
button to clear all records an error may occur.



Status: This problem is resolved.

4. Modification: Made minor cosmetic changes.
v1.5 build 1

1. Problem: On the Levels tab, sometimes if the Level SQL statement cannot run
properly, when the user clicks the Apply button to save it, an error message will
display and the SQL statement change to blank.

Status: This problem is resolved.

2. Problem: On the Test Field SQL tab when the user clicks the Load Data button,
if the SQL statement has invalid columns when the DataViewer Designer
software tries to remove the invalid columns an error would occur.

Status: This problem is resolved.

3. New Feature: On the Field Info tab, when the user clears all the Field Info
records and than populates the FieldInfo records immediately, the new populated
records will keep some old setting values (such as “Alias”, “Field Order”, “Can
Be shown” etc.)

4. New Feature: On the Level tab, the maximum length of Level SQL statement is
no longer limited to 8000 characters.

5. Modification: Made minor cosmetic changes.

6. New Feature: The Release Notes menu will now show the PDF version of the
release notes file if Adobe Reader is installed. If Adobe Reader is not installed,
the release notes will be displayed as they have in previous versions.

v1.5 build 0
1. New Feature: Updated DevExpress controls to the latest version.
2. Modification: Made minor cosmetic changes.

v1.4 build 9

1. New Feature: DataViewer Designer Enterprise will update the Field Info table
records to remove table name from “Field Name” column and “Field SQL”
column.

2. Modification: DataViewer Designer Enterprise no longer uses the “DVEnterprise
DB Name” setting in the “Vemax.Globallnfo.dat” file.

3. Modification: On the Levels tab, the default value for “Max Records for Grid” is
set to 0 that means there is no maximum limit.

4. New Feature: On the Levels tab, if the SQL statement for this level is blank,



DataViewer Designer Enterprise doesn’t validate it.

New Feature: On the Levels tab, after the “Query Builder” dialog is closed
DataViewer Designer Enterprise will check if the returned SQL statement has
repeated fields. If there are repeated fields, DataViewer Designer Enterprise will
automatically add an alias for each field. The alias is formed by table name plus
‘_’ plus field name.

The “Apply” button does the same check.
Problem: Sometimes when a Level is deleted an error message says that the SQL

Server View is not dropped properly.
Status: This problem is resolved.

7. Modification: Made minor cosmetic changes.

v1.4 build 8

1.

New Feature: The program will now automatically remember the Configuration
that the user was last was in upon logging out of the system. This feature was
added so each user no longer has to change the Configuration each time they log
in if the default Configuration is not the one they want. No additional setting is
required for this feature.

New Feature: On the “Test Field SQL” tab, added “Show SQL” button so the
Configuration Manager can see the SQL statement that is automatically created
from Field Info. This is the actual SQL statement that DataViewer Enterprise
uses.

Modification: On the “Test Field SQL” tab, the grid is now displayed more like
the grid in DataViewer Enterprise.

New Feature: On the “Levels” tab, the SQL statement now supports “GROUP
BY”, “ORDER BY” and other clauses so that DataViewer Enterprise supports
much more powerful queries.

Note if the ORDER BY clause is added then the clause “Top 100 Percent” must
be added after the word: “Select”.

For example:

Select Top 100 Percent *

From tblCrew

Order By Code

Problem: On the “Test Field SQL” tab, when the “Load Data” button is clicked
the program uses the Field SQL statement to load the data. If the Field SQL
statement is not correct the program will display an error message. When you try
to close the error message it does not close properly and the grid is disabled.
Status: This problem is resolved.



6. Modification: Made minor cosmetic changes.

v1.4 build 7

1. New Feature: On the Export DataViews and Import DataViews screens, a check
box “SQL Views” has been added. This allows the Configuration Manager to
decide if he or she wants to export or import any SQL Views that were created by
DataViewer Designer. When exporting the DataViews, the Configuration
Manager can set the order the SQL Views will be exported in. The order is very
important if some SQL Views reference other SQL Views. The referenced SQL
View must come before the SQL View that is using it.

2. Problem: On the Field Info tab, if the menu item “Auto Create SQL Server
View” is checked, the SQL Server Views will not be created properly. This
problem seems to have started in version: 1.4 Built 5 of DataViewer Designer.
Status: This problem is resolved.

3. Problem: On the Field Info tab, changes to “Bin/Calculate” column were not
being saved properly.
Status: This problem is resolved.

4. Modification: Improved the Import process of SQL Server Views.

v1.4 build 6
1. Problem: On the Form Report tab, after creating a new Form Report if the user
clicks the “Save as” button to save it as a different name and then when the user
clicks Designer to open the Form Report, an error may occur.
Status: This problem is resolved.

2. Problem: Occasionally, on the Form Report tab, when the user opens the Report
Designer to make some changes and closes the designer, when he or she opens the
designer and changes the Form Report again, an error may occur.

Status: This problem is resolved.

3. Problem: If a DataView has Form Reports created for it and the user changes the
DataView name, the DataView may lose its Form reports.
Status: This problem is resolved.

4. Problem: Form Report: if a renames the first Form Report without opening or
previewing the Form Report, the report may be lost.

Status: This problem is resolved.

5. Modification: Made minor cosmetic changes.

v1.4 build 5
1. Problem: Field Info tab: if a user clicks the Copy Images button and then clicks



the Cancel button, an error may occur.
Status: This problem is resolved.

2. Problem: Field Info tab: the Binning button is all the way to the right hand side
of the icon bar.

Status: This problem is resolved.

3. Problem: Field Info tab: if a user manually adds some Field Info records, and
then opens the Delete Fields dialog to delete records including the newly added
records an error may occur.

Status: This problem is resolved

4. Problem: Field Info tab: if a user manually adds Field Info records and then
clicks the Populate Field Info button an error may occur.
Status: This problem is resolved

5. New Feature: On the Field Info tab, added SQL Views menu to let the user Save
SQL views created by the FieldInfo fields.

6. Modification: Made minor cosmetic changes.

v1.4 build 4

1. New Feature: Add a Populate Fields dialog form. When the user clicks the
“Populate Field Info” button, the new form is opened and lists all populated field
records and new fields to populate. This gives the user the option to select fields
he or she wants to populate without overwriting existing fields or adding duplicate
fields.

2. New Feature: Add a Delete Fields dialog form. When the user clicks the “Delete
Field Info” button, the Delete Fields dialog form is opened and lists all populated
field records. This gives the user options to select fields he wants to delete.

3. Problem: Field Info tab: when the user uses the New Field Info button to create a
new field record, and the user enters the field name enclosed with “[”, “]”, the
program adds another set of square brackets and the Field Order value is not set
for the new field.

Status: This problem is resolved.
4. Modification: Made minor cosmetic changes.
v1.4 build 3
1. Problem: Form Report: if a DataView has no levels with the checkbox Available

for Form Report checked, and they click the New button to create a new Form
Report, a message will display telling them no levels have this checkbox checked.
But when they then try to navigate between the level and DataView notes an error
occurs.



Status: This problem is resolved.

2. Modification: Made minor cosmetic changes.

v1.4 build 2

1.

Modification: On Form Report preview screen, removed direct print button to
avoid printing all pages by mistake.

New Feature: On Form Report preview screen, when user wants to print Form
report, set printer name is set to local default printer.

Modification: On Form Report tab, added “Default” column to Form Report grid.
User can choose one Form Report as the default report.

Modification: On Form Report tab, if there is no Form Report available, only the
New button is enabled.

Modification: when creating a new Form Report, a dialog screen will be
displayed to ask the user to input a new Form Report name. If the name already
exists then the program will asks the user if he or she wants to enter a different
name. If the user clicks the No button, the program will return to the main screen.

6. Modification: Made minor cosmetic changes.
v1.4 build 1
1. Problem: On Form Report tab, if there is no Form Report record in the grid,

when the user clicks any button like “Save As”, “Designer”, “Preview” or
“Delete”, an error would occur.
Status: This problem is resolved.

Problem: On Field Info tab, when the user creates a new Bin. The grid doesn’t
display the “Output Bin Value” column.
Status: This problem is resolved.

3. Modification: Made minor cosmetic changes.
v1.4 build 0
1. New Feature: Added Form Report functionality so form-style reports can be

created in DataViewer Designer Enterprise and displayed and printed in
DataViewer Enterprise.

Problem: When the user clicks F5 button to refresh the screen, an error would
occur.
Status: This problem is resolved.



3. New Feature: Updated DevExpress controls to the latest version.

4. Modification: Made minor cosmetic changes.

v1.3 build 15

1.

Problem: In the Field Info tab, sometimes the Populate Field Info button
duplicated some fields record.
Status: This problem is resolved.

Modification: Made minor cosmetic changes.

v1.3 build 14

1.

6.

7.

Modification: Updated to the latest DevExpress controls to fix some defects in
the grid and improve performance.

Problem: When a user changes a Config Name, Group Name or DataView
Name in Designer, the related Field Values information is changed however this
caused and error when opening the Field Values screen.

Status: This problem is resolved.

. Problem: When a user changes a Group Name and clicks the Apply button. The

new Group name isn’t shown in the tree control. If the user moves the focus
away from the current group node and goes back to the same group again, an
error would occur.

Status: This problem is resolved.

Problem: The Populate Field Info button still re—adds all the fields if the Alias
has been changed.

Status: This problem is resolved.

Problem: On Field Info screen, when the user clicks the New Field Info button,
an invalid data message is displayed and an error icon shows in the Alias column.
Status: This problem is resolved.

Modification: Modified the screen size to fit 800x600 screen resolution.

Modification: Made minor cosmetic changes.

v1.3 build 13

1.

2.

Problem: When creating a new level, the default setting for “Max Records in
Grid” and “Max Records in Chart” are reversed.
Status: This problem is resolved.

Modification: Made minor cosmetic changes.

v1.3 build 12



1.

Modification: Changed the screen size of Export and Import to fit 800 x 600
screen resolution. Enabled the screen maximize button and resizable button.

2. Modification: Made minor cosmetic changes.

v1.3 build 11

1.

3.

4,

New Feature: Export/Import dialog screen: added “Select/Unselect All” Group
box control. Moved Select, Max Records Check boxes and added two new check
boxes into the control: Agency and Field Values. Added two Agency and Field
Values columns in the Export grid. If the Agency check box is checked in the
column then all the Agency-specific Layouts, Advanced Filters, Data Summaries,
etc in DataViewer Enterprise will be included in the Export/Import for those
DataViews. Likewise with the Field Values.

New Feature: Export/Import dialog screen: made the operations in Check boxes
and Columns more logical and smart. For example, if user un-checks the Select
Check box in the group control, the program will un-check Select, Agency, Field
Values, and Max Records columns for all rows in the grid.

New Feature: DataView Details screen: added Owner options.

Modification: Made minor cosmetic changes.

v1.3 build 10

1.

New Feature: Added “Max Records in Grid” and “Max Records in Chart” input
boxes on Level tab screen. Users can set max records limited for pacific level.

Modification: Changed “Import DataViews” and “Export DataViews” functions
to let the users decide if they want to export/import the “Max Records” settings
for each DataView.

Modification: Made minor cosmetic changes.

Modification: Changed Display Format dialog to make it more easy to use and
powerful.

v1.3 build 9

1.

Problem: Intermittent errors would occur when populating the Field Info.
Status: This problem is resolved.

Modification: Increased the size of the “Field Order” screen to show all three
columns.

Problem: When importing data views, if one data view failed to import, the
program stops importing the rest of the data views and doesn’t show any error
messages. It should keep importing the rest of the data views and show error



message listing which data view(s) failed to import.
Status: This problem is resolved.

4. Modification: Removed the up/down buttons from all Spin Edit controls.

v1.3 build 8
1. Problem: When the user clicks F5 to refresh the current screen. The program
always goes back to the default configuration.
Status: This problem is resolved.

2. Modification: On the FieldInfo tab, removed the table owner as the prefix in the
alias field when the user populates Field Info if the field has owner name.

v1.3 build 7
1. New Feature: Added a “Manual” menu item in Help menu on the main screen.
User can view designer manual by clicking on this item (currently as a PDF file).

2. New Feature: When a user clicks the “New Config” button, the program sets the
cursor focus on the first input field.
The same as “New Group”, “New DataView”, “New Level” buttons.

v1.3 build 6
1. New Feature: Added a “Change Password” menu item in Option menu on the
main screen. User can change password by clicking on this item.

2. Problem: Sometimes the application cannot be closed properly if an error
occurs.
Status: This problem is resolved

3. New Feature: When DataViewer Designer is run, it checks the database version
to make sure the correct version of the DataViewer Update DB utility has been
run on that database.

v1.3 build 5
1. Modification: On the Field Info screen, when populating the Field Info table,
only the field that appears more than one time in the Level SQL statement will
have its table name as prefix for alias.

2. New Feature: Added the “Set Field Order” button on the Field Info screen to
enable the user to easily set the field order by moving up/down record buttons.

3. Problem: In the Field Info screen, if the user types a blank space for field name
or for alias and then goes to another row, the validation function will show an
error icon on the new row instead of on the row with the invalid entry.

Status: This problem is resolved.



4. Modification: In the Field Info screen, the mouse wheel will no longer change
the field order value. This is to avoid inadvertent changes.

5. New Feature: Added an “Add New Record” button on the main screen. When
the user clicks this button, depends on where the focus is, a blank screen will
shown to let the user set new record.

6. New Feature: Added a “Save Current Record” button on the main screen. When
the user clicks this button, the current record will be saved to database.

7. New Feature: The Current Users list is now maintained so a DBA can see who is
logged into a database via the application.

8. Modification: Updated the Query Builder components.

9. Modification: Made minor cosmetic changes.

v1.3 build 4

1. Problem: When import DataViews, sometimes error message 9472 shows up,
The system information for this error is: “INSERT statement conflicted with
COLUMN FOREIGN KEY constraint INSERT statement conflicted with
COLUMN FOREIGN KEY constraint” or “Cannot insert duplicate key in object
‘tbIProcessProperties’”’;

Status: This problem is resolved.

2. Problem: When importing DataViews, if the program fails to create the SQL
view, it stops to import all other groups and their DataViews.
Status: This problem is resolved.

3. New Feature: Add check box “Filter by Computer Name” on Levels tap.

4. New Feature: if a field name is “ID”, when user clicks ‘Populate Field Info’ to
populate fields, the “Can be Shown” column field is unchecked on.

5. New Feature: Field alias is “Mixed Cased” when populate fields.

v1.3 build 3

1. Problem: If the user tries to set the display format for a date type field that
already has an old setting, only the selected type can be shown in the “Sample
Display Format” drop down list.

Status: This problem is resolved.
2. Problem: On the “Export DataViews” screen, when the user selects some

DataViews to export and clicks the “Close” button then clicks the “No” button in
the confirmation dialog, an error will occur if the user tries to close to dialog
again.



Status: This problem is resolved.

3. Modification: Made minor cosmetic changes.

v1.3 build 2
1. New Feature: In Field Info tab, when the user clicks on the “Populate Field
Info” button, the “Field Order” column is automatically populated based on the
order of the columns in the SQL View or query if it is not already set.

2. Problem: When creating a new level, the master/detail grid would not display the
data if there is space in the field names used to set “The Primary Key Field
Name” or “Link Key Field Name” for the master or detail levels.

Status: This problem is resolved.

v1.3 build 1
1. New Feature: Added “Display Format” column in Field Info Grid so the
Configuration Manager can set field pacific display format.

v1.3 build 0
1. New Feature: Updated DevExpress controls to the latest version.

v1.2 build 61
1. Problem: If the user changes a current Config name and then import the
Dataview to this original Config name, an error will occur.
Status: This problem is resolved.

v1.2 build 58
1. Problem: In the Level tab page, if the SQL Statement has “order by and in the
Field Info tab page, the Auto Create SQL Server View check box is checked, then
when save the record, an error will occur.
Status: This problem is resolved.

2. Problem: When clicking the Data Viewer tool bar, the DataViewer Enterprise
application will begin to run, but the user has to login.
Status: This problem is resolved.

3. Modification: Made minor cosmetic changes.

v1.2 build 57
1. New Feature: Added the Release Notes menu.

v1.2 build 56
1. Problem: In the File menu, when you click “Import DataViews...” the Import
dialog will show. If you then click the “Select/Unselect all data views in the list
below” check box, which unselects all data views, and then select only some data
views in the Select column, the first data view in the internal dataset will always



be selected, although it is not selected in the grid.
Status: This problem is resolved.



